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Reverse engineering is a technology that enables acceleration 
of data acquisition for CAD, CAM, CAE systems and thus greatly 
reduces the time of development, design and production of 
components. In general, reverse engineering technology can be 
considered as the conversion of analog data to digital data, 
which is further processed. Individual industries are still 
increasing their demands for accuracy, size, quality, and so, 
therefore the use of digitization is found in many 
manufacturing areas such as the automotive, aerospace, 
shipping, medicine, industrial design, design, and so on. The 
paper deals with the analysis of the prototype component of 
the agitator gearbox in the form of a rough and chip-machined 
casting. The inspection of the shape of the gearbox consisted in 
reading the reference CAD model, establishing the digitized 
shape with respect to this reference model, checking the 
dimensions and creating a color map of the variations at 
selected points. 
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1 INTRODUCTION  

Reverse engineering technology is one of the promising 
emerging areas of contemporary engineering. Reverse 
engineering is characterized by the opposite sequence of 
activities towards the classical production process. In the 
classical process, the designer builds on the basis of proposals a 
design of virtual CAD model of some component, which 
becomes a model for the production of a physical part. In 
reverse engineering, initially, a physical object is converted to 
model data by the digitization, with which the designer can 
work further with the available CAx data processing 
applications  [Navratil 2000] [Piska 2009]. 
Reverse engineering technology allows you to measure data or 
check the component in a relatively short time compared to 
conventional measurement techniques. The time required to 
measure a complex component is shortened from weeks to 
hours, up to a maximum of days. With the increasing 
complexity of the product, the application of this technology is 
more advantageous [Navratil 2000] [Piska 2009]. 

2 ATOS SYSTEMS  

ATOS systems are widely used for the most demanding 
digitization applications. Specific design based on two CCD 

cameras and light projection principle allows you to calculate 
digitized data using a stereo method. Combined with the 
reference point method used to automatically link individual 
views, the stereo method creates very high quality data. With 
this technology, ATOS takes the lead in quality control 
applications and demanding industrial digitization. The ATOS 
scanner can easily be adapted to different measurement sizes, 
with easy calibration and easy calibration of the system based 
on supplied calibration elements [Navratil 2000] [Piska 2009]. 
The resulting data set of measurements is very high quality STL 
file, the 3D coordinates of points, cross-sections, contour lines 
or output quality protocols. ATOS software allows you to 
evaluate and compare measured data files with default CAD 
geometry or a scanned reference piece and perform extensive 
analyzes of measured data [Navratil 2000] [Piska 2009]. 

2.1 Digitization 

Digitization is a digital image acquisition process where the 
continuous image function f (x, y) is replaced by the 
corresponding discrete function I (x, y). Digitization takes place 
in two steps [Navratil 2000] [Piska 2009] [Sedlak 2008a]: 

 quantization, 

 sampling. 
Each conversion of a continuous function to a discrete one is 
necessarily associated with the occurrence of an error, which is 
caused by the loss of part of the information of the original 
continuous function. By appropriately setting the digitization 
parameters, e.g. sampling frequency or quantisation interval, 
these errors should be minimized so as not to negate the 
information contained in the digital image. Digitization is done 
using digitizers (scanners). These devices can work on different 
principles that predict the way digitization is done. The choice 
of the digitization method or the reverse engineering method is 
affected by the following factors [Sedlak 2008b] [Zouhar 2007]: 

 preparing the prototype of the upper / lower gearbox 
of the stirrer, 

 the acquisition of individual scans, 

 the connection and polygonization of each scan, 

 adjustment of the protrusion of the upper / lower 
gearbox of the agitator. 

An ATOS Compact Scan 2M Optical Scanner from GOM GmbH 
was used to digitize the stirrer gearbox and obtain nodal points. 
The device is located at the complex graphic workplace of the 
Faculty of Mechanical Engineering, BUT. ATOS Compact Scan 
2M is an ATOS-based, blue-light projection technology with two 
digital cameras each with a resolution of 2 million pixels. Very 
simply, the scanner projects light stripes on the surface of the 
model, which are captured by two 1623 x 1236 pixel CCD 
cameras. Subsequently, using the mathematical methods, it is 
automatically calculated the location of the points in the space. 
Based on the identification of individual points by both cameras 
and using the principle of optical triangulation, the spatial 
coordinates of the given points are calculated. For scanning, 
self-adhesive reference points with a diameter of 3 mm are 
used. New projection technology with an integrated light 
control unit - The blue LED used by ATOS is resistant to 
changing ambient lighting. The accuracy of the scanner is 
determined by using VDI standards according to VDI 2634 for 
optical systems [GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Sedlak 
2008b] [Zouhar 2007]. 

2.1.1 Triangulation 

Triangulation is a frequent method of digitizing objects. Fig. 1 
shows the principle of triangulation. The source sends a laser 
beam to the object to be measured. The camera captures the 
reflection of the ray from the object surface. The source and 
the camera make an angle α and are separated by a value b. 
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The source, the camera lens, and the point of the incident ray 
together form a triangle. The distance from the object is 
calculated according to the relationship (1) [Raja 2008] [Sedlak 
2007] [Sedlak 2003] [Stylianou 2010] [Weber 2010]. 

 
 

Figure 1. Principle of triangulation [Pieraccini 2001] 

Distance from the object [Pieraccini 2001]: 

   1tanbr  [mm]      (1) 

Where: 

  - the angle between the source and the camera [°], 

  - the angle between the camera and the sensor [°], 

 r  - distance from object [mm], 

 b  - source and camera distance [mm]. 

2.1.2 Methods based on stereovision 

Methods based on stereovision use the principle of 
stereoscopy, which is to capture the image by two cameras, see 
Fig. 2. Individual cameras create a 2D image of a given scene 
from a different point of view. The resulting geometry is 
obtained from the mutual orientation of the cameras and the 
different positions of the points recorded by the right and left 
camera (disparit). The main problem of stereo vision is the poor 
correspondence of the matching points in pictures with a slight 
texture or edges. The correspondence problem causes 
inaccurate measurements, and therefore stereovision is often 
used in combination with various active methods. Stereovision 
has many applications, especially in the areas of advanced 
technologies [Zatocilova 2013] [3D Measurement MAPV 2009]. 

 
 

Figure 2. Typical stereovision system [3D Imaging with NI LabVIEW 
2012] 

2.1.3 Fringe Projection Method 

As shown in Fig. 3, light stripes are projected onto the scanning 
surface. Upon impact on a surface that is not flat, the strips are 
deformed. The resulting image is scanned by one or two 
cameras and using the algorithm the system calculates the 
coordinates of the individual points in the space. Advantage of 
the method is a large number of measured points from one 
frame [GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Zatocilova 2013].  

 
 

Figure 3. Principle of the Fringe Projection Method [Pieraccini 2001] 

3 DIGITALIZATION OF THE MIXER GEARBOX PROTOTYPE 

The digitization of the mixer gearbox prototype took place in 
several steps. The first step was the preparation of the 
prototype, which included the placement of the reference 
points and the surface treatment. To connect the individual 
scans taken from different angles of view, it was necessary to 
use appropriately positioned reference points. These points 
were automatically recognized and their location in the space 
was recorded for each scan. The exact spatial position of the 
individual scans is evaluated using these points. In each new 
scan, it was necessary to capture at least three points from the 
previous scan [GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Sedlak 
2008b] [Zouhar 2007]. 
When making individual scanning it was possible to move both 
the model and the scanner. After focusing the scanner on the 
desired area, the object is illuminated, thus initiating the 
digitization process to be reached [GOM GmgH] [MCAE 
SYSTEMS, s.r.o.] [Sedlak 2008b] [Zouhar 2007]: 

 capturing reference points, 

 projection of light stripes. 
Subsequently, the positioning and display of scanned points are 
calculated. After capturing the entire surface, the next step was 
to align each scan. Alignments were smoothed or scanned with 
large deviations. The sequential step was polygonization, where 
the scanned points were approximated by a triangular network. 
The size and density of the resulting network can be controlled 
by user-adjustable parameters. The polygon network requires 
further adjustments, such as adherence of holes to reference 
points, smoothing and optimization (triangle reduction). The 
final step was to export the model to the STL format (most 
common format) [GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Sedlak 
2008b] [Zouhar 2007]. 

3.1 Quality of digitized data and CAD compatibility 

The quality of the resulting polygonal network is very important 
for further processing in reverse engineering, rapid prototype 
production, and for inspection analysis. Outputs from the ATOS 
scanner have long been recognized in the 3D digitization 
market due to the quality of the data the scanner generates. 
The powerful tools for calculating the polygon data network are 
further optimized as well as the polygon network editing 
functions [GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Sedlak 2008b] 
[Zouhar 2007]. 

4 INSPECTION OF MIXER GEARBOX CASTING 

The casting inspection was performed using the ATOS Compact 
Scan 2M Non-contact Optical Scanner. The analyzed prototype 
component was the agitator gear box in the form of a rough 
(not machined) and chip-machined casting. The inspection of 
the shape of the gearbox consisted of loading a reference CAD 
model, establishing a digitized shape with respect to this 
reference CAD model, checking the dimensions and creating a 
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color map of the variations at selected points. The default data 
for shape inspection was the polygon mesh of the agitator 
gearbox shown in Fig. 4 [FRVS 2013] [GOM GmgH] [MCAE 
SYSTEMS, s.r.o.] [Shape Inspection of Component]. 

 
Figure 4. General view of the formed polygon network [GOM GmgH] 

4.1 Inspection of component shape - comparison of the 
digitized and reference CAD model 

The tools for measuring and comparing variations of the 
digitized part of the component and the reference CAD model 
were available in the GOM Inspect program. The contextual 
icon menu, see Fig. 5, offers the alignment of the scan and the 
reference model, the comparison of the surface shape, the 
point inspection, the inspection with cuts and the I-inspect 
function, such as measuring distances, deviations and 
geometric tolerances etc. It was necessary to import CAD data 
and set them on a polygon network [FRVS 2013] [GOM GmgH] 
[MCAE SYSTEMS, s.r.o.] [Shape Inspection of Component]. 

 
Figure 5. Tools of the Inspection Icon Menu [GOM GmgH] 

4.2 Import of the reference CAD model 

The import of the reference CAD model was done using the 
"File -> Import" menu. For common purposes, it is not 
necessary to change the import parameters. In the element 
tree, there is a "Nominal elements" section with a reference 
CAD model. The digitized and reference CAD models are still 
using their coordinate systems and are not aligned with each 
other, see Fig. 6 [FRVS 2013] [GOM GmgH] [MCAE SYSTEMS, 
s.r.o.] [Shape Inspection of Component]. 

 
Figure 6. Digitized model and reference CAD model - unassigned [GOM 

GmgH] 

4.3 Pre-set of the reference CAD and digitized model of the 
mixer cabinet - Initial Alignment 

To set a reference CAD model to polygon data, use the tools 
found in the main menu. The first step should always be a pre-
set up. The easiest way is automatic preloading using the 
"Prealignment: Operations -> Alignment -> Initial Alignment -> 
Prealignment" tool, see Fig. 7. If both models do not resist after 

confirmation, you need to increase "Search time" [FRVS 2013] 
[GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Shape Inspection of 
Component]. 

 
Figure 7. Pre-set of the reference CAD and digitized model [GOM 

GmgH] 

4.4 Inspection of the diameter of the mounted cylindrical 
part of the mixer housing casting 

To control the casting diameter of the mixer casting, a 
cylindrical surface was formed on the digitized network. On the 
digitized network when the reference CAD model was off, a 
cylindrical surface was selected. To select the surface of the 
diameter, the "Edit -> Selection in 3D -> Geometry Based 
Selections -> Select Cylinder Based" menu option was used, as 
shown in Fig. 8. A cylindrical surface was created using the 
"Construct -> Cylinder - > Auto Cylinder (Nominal)", see Fig. 9 
[FRVS 2013] [Shape Inspection of Component]. As a result of 
the cylindrical surface, it was deduced that its radius was 
28.498 mm. In the same way, the radius on the mounted 
cylindrical part, which is 28.500 mm, can be subtracted from 
the referenced CAD model (when the digitized model is turned 
off), resulting in a deviation of the actual diameter on the 
mounted cylindrical parts of the mixer (28.498 – 28.500) x 2 = -
0.004 mm [FRVS 2013] [GOM GmgH] [MCAE SYSTEMS, s.r.o.] 
[Shape Inspection of Component]. 

 
 

Figure 8. Selection of surface mounted diameter of the mixer casting - 
digitized net [GOM GmgH] 

 

 
 

Figure 9. Creating a cylindrical surface on the surface of the mixer 
casting diameter [GOM GmgH] 

4.5 Final set-up of the reference CAD and digitized mixer 
housing model – Alignment 

The "Local Best-Fit" method, which searches for the best match 
between CAD and the digitized model on selected (local) 
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mutually matching surfaces, was applied for the final set-up. In 
this case, the machined surfaces of the resulting components 
had to be used, since the casting surface without machining 
could be expected to have a significantly greater variation. The 
"Edit -> Selection in 3D -> Geometry Based Selections" menu 
could be used to select the machined surfaces. In this way, the 
face plane of the surface of the cast plunger diameter (Select 
Plane-Based) and the outer surface of the cast die diameter 
(Select Cylinder-Based) has been selected, see Fig. 10. The final 
setting was done using Local Best-Fit, see Fig. 11 [FRVS 2013] 
[GOM GmgH] [MCAE SYSTEMS, s.r.o.] [Shape Inspection of 
Component]. 

 
Figure 10. Selecting surfaces for mutual alignment [GOM GmgH] 

 

 
Figure 11. Mutual setting using the "Local Best-Fit" function [GOM 

GmgH] 

4.6 Display of true shape deviations 

Viewing deviations of the digitized shape was performed by the 
Inspection -> CAD Comparison -> Surface Comparison on CAD. 
The range of the color legend can be selected as required but 
always with respect to the desired part [FRVS 2013] [GOM 
GmgH] [MCAE SYSTEMS, s.r.o.] [Shape Inspection of 
Component]. 

4.6.1 Color map of deviations 

For the software comparison of the shapes of the two model 
parts, the reference CAD model and the part model, or the 
element on the model with the ideal geometric element, the 
so-called color maps are used, see Fig. 12. The individual 
compared components were first precisely set in the same 
coordinate system and then overlapped. Instead of setting in 
the coordinate system, the so-called "Best-Fit" function was 
used, which based on the mathematical calculation establishes 
the components on top of each other so that the distance 
between the corresponding points on the surface of the 
individual components is minimal. In addition, according to the 
specified parameters, a texture has been generated on the 
surface of the overlapped parts, which has the following 
property - after the set steps, a certain color or shade is 
assigned to a certain distance between the measured points on 
the surface. For example, if the red color means the distance 
between the surfaces larger than the holiday, it is possible to 
see the red color on the surface of the overlaid parts wherever 
this distance is exceeded. In order for the result to have 
sufficient information, one of the measured elements should be 
determined as a reference, which is one that the system will 

consider ideal and the distance to measure [FRVS 2013] [GOM 
GmgH] [MCAE SYSTEMS, s.r.o.] [Shape Inspection of 
Component]. 

 
Figure 12. Colored map of deviations [GOM GmgH] 

5 DISCUSSION OF THE ACHIEVED RESULTS  

Component Inspection: "Reference CAD Model" vs. "Chip 
machined selected cast surfaces - upper / lower half of 
digitized mixer gearbox": 

 Displaying the resulting deviations at the selected 
points, see Fig. 13 and Fig. 14. 

The reference model for the upper / lower half of the mixer 
gearbox is the parametric model supplied by the company 
("Reference CAD model") against which the digitized upper / 
lower half of the mixer gearbox ("Machined selected casting 
surfaces - upper / lower half of the digitized mixer gearbox"), 
see Fig. 13 and Fig. 14 [Sedlak 2016]. 
Results obtained by inspection of the upper / lower chip 
machined half of the mixer gearbox [Sedlak 2016]: 

 The ATOS Compact Scan 2M optical scanner only 
captured the surface of the prototype upper / lower 
of the mixer gearbox. 

 No proportional asymmetry (scattering of values) was 
detected at the prototype upper / lower of the mixer 
gearbox during the inspection, which would affect the 
manufacturing inaccuracy of the casting or chip 
machining of the required functional surfaces. 

 A chalk powder with a thickness of about 0.05 mm 
was sputtered on the surface of the toothed wheel 
prototype. The chalk powder has been applied 
uniformly to the surface, but it is not excluded that an 
unsymmetrical deposit could occur which would 
affect the magnitude of the dimensional variations at 
the selected points. 

 For the digitization of the prototype upper / lower of 
the mixer gearbox using the ATOS Compact Scan 2M 
optical scanner, a measuring range of 250 x 190 x 190 
mm3 was used, which, due to the size of the 
prototypes of castings (capture of all details). 

 None anomalies were detected on the digitized 
prototype of the upper / lower of the mixer gearbox, 
which would affect their production process. 
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Figure 13. Mutual alignment of the reference CAD prototype and the 

digitized STL model of the upper half of the mixer gearbox (chip 
machined selected casting surfaces) [GOM GmgH] 

 

 
Figure 14. Mutual alignment of the reference CAD prototype and the 

digitized STL model of the lower half of the mixer gearbox (chip-
machined selected casting surfaces) [GOM GmgH] 

Analogous results were also obtained for [Sedlak 2016]: 

 Gross cast - "Reference CAD model" vs. "Upper half 
of the digitized mixer gearbox", see Fig. 15. 

 Gross cast - "Reference CAD model" vs. "Lower half 
of the digitized mixer gearbox", see Fig. 16. 

The difference to the machined surface of the required 
functional areas was only in the machining accessories. No 
deformations were found on both agitator gearbox castings, 
which would affect the production process (machining, 
assembly, noise, sprocket life, total manufacturing inaccuracy). 

 
Figure 15. Mutual alignment of the reference CAD prototype and the 

digitized STL model of the upper half of the mixer gearbox (rough 
casting) [GOM GmgH] 

 

 
Figure 16. Mutual alignment of the reference CAD prototype and the 

digitized STL model of the lower half of the mixer gearbox (rough 
casting) [GOM GmgH] 

6 CONCLUSIONS 

The use of reverse engineering methods is a useful tool for 
retrofitting and creating missing 3D documentation. With 
enough information, it is appropriate to combine the data 
obtained by digitizing with the "ideal" 3D model created on the 
basis of 2D documentation. 
Based on actual object scanning, a number of measurements 
can also be performed using appropriate programs. In practice, 
these measurements would be either very difficult to 
implement or would not be feasible at all. 
The aim of the paper was to analyze the prototype upper / 
lower case of mixer gearbox in the form of rough and chip-
machined castings (selected functional surfaces). The 
inspections found that the measured deviations of the 
dimensions at the selected points (see the legend of the color 
display of the map of deviations) relative to the upper / lower 
half of the mixer gearbox reference CAD correspond to the 
tolerance on the drawing documentation, the accuracy of the 
equipment used, the part preparation before digitization Chalk 
powder) and human factor. 
ATOS scanners are highly accurate devices with high 
measurement reliability. The scanner continuously monitors 
the situation before, during and after measurement. The 
monitoring monitors the relative movement of the scanner - 
the measured object, the change of ambient light, and the 
calibration of the scanner is checked at each measurement. The 
new Blue Light projection technology used by the scanner is 
resistant to changing ambient lighting. The accuracy of the 
scanner is determined using VDI standards according to VDI 
2634 for optical systems. 
3D scanners are suitable for components of more complex 
shapes with general surfaces. From the digitized data, you can 
obtain information about the component dimensions, the 
geometric deviations of the whole component and the 
variations in the individual points. 
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